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PART A: Scenes in Flash 
 

 
Scenes are used to break down a movie into smaller, 
more manageable sections. It helps keep the movie 
organized. Each scene has its own timeline. Like a movie 
script, these scenes can be considered “acts” in the 
movie. Scenes play in the order they are listed the Scene 
panel and can be rearranged (just drag and drop). If a 
stop action is inserted in a Scene, the movie will not 
continue to the next Scene. 
 

For this movie, we will have two scenes: Scene 1 and Scene 2. Open the Scenes panel (Shift+F2 
or click Window > Scene). Insert a second scene by pressing the plus sign and name it Scene 2. 
 
When all is said and done, your Scene panel should match the one above left. 
 
 
Open Scene 1 (just click on it) and pay attention to where the name of the Scene is.  
 

 
 

To change the background color (which, incidentally, applies to ALL Scenes), be sure the arrow 
tool is selected and click the Background color swatch in the Property panel (Property 

Inspector). Select the darkest blue you can find. 
 

 
 
Also in the Property Inspector, set the size for your movie. The default is 550x400. It is probably 

a good idea to bump that up to 640x480 for most movies (or bigger).  

Intro: Save the Disney Kit 
 

Download the Disney Kit.fla from the website. It has all the graphics that you’ll need in 

the Library. Double-click to open it in Flash. Immediately, File > Save as and save a copy 

in your Digital Tools folder. 
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PART B: Text in Flash 
 

Text boxes have three different types—static, dynamic, and input. For this tutorial, we will only 
be using static text. That means it is ‘plain old text.’ Be sure your Property Inspector says static 
as the type or the text box will not work properly. 
 
For this movie, our introductory Scene is going to be something simple--words fading in and  
flying out. So, let’s get started! 
 

Click the Text Tool . In the Property Inspector, set your text type to static, font to Berlin 
Sans FB (or similar font), size 37, white, and italic. 

 
 

Click in the middle of the Stage (the big area in the middle of the screen) and type 
PRESENTING…  Click the arrow tool and then click back on the words you just typed. They 

should get a blue box around them.  
 
Now, let’s center this puppy. Bring up the Align panel (Window > Align).  Be sure that the 
button under “To Stage” is clicked. Then click the horizontal and vertical alignment buttons.  
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BIG RULE: In order to apply animation in Flash (called tweening), the object must be a symbol. 
There are three types of symbols—graphics, movie clips, and buttons. For this text portion of 
the lesson, we will convert the text to graphic symbols. 
 
To convert to a symbol, be sure the text is selected with the arrow tool, click Insert, Convert to 
Symbol (or press F8). Then, give it a name, set behavior to Graphic, and press OK. Let’s name 
this Presenting. 

 
When you create a symbol, it is stored in the library (F11).  

Any change made to the original symbol will be updated in your movie. You can use a symbol 
multiple times. 

  
(notice in the right side picture that there is a little circular target thingie in the middle…this indicates 
that the text has indeed been converted to a symbol) 

 

Now, let’s talk Timeline. At the bottom of your screen is the Flash 
Timeline. It starts with one layer (Layer 1). You have one item on 
that layer (presenting). You can rename a layer by double clicking 
its name, typing in a new name, and pressing enter. Rename the 
layer as presenting.  
 
LESSON: Notice on the timeline that you have a black dot in frame 
1. That black dot is a keyframe. Keyframes are frames that have 
something in them. What’s in it? Well, the presenting symbol, 

that’s what! If it had an empty circle in it, that would be a blank keyframe (ready for you to put 
something in it). If it has an empty square in it, that is a frame. Frames are just continuation of 
keyframes (they are just “staying up there” for all to continue to see).  
 
We are going to make the text move now (yippee!). To do that, we need a keyframe that gives 
us the starting line and a keyframe that gives us the finished location. So, click on the Timeline 
in frame 10. Right click that frame and insert a keyframe (F6). A black dot should appear. That 
keyframe is our finished location (with text centered nicely). 
 
So, let’s go back to keyframe 1. We want to change the text here so it is invisible if we want it to 

fade in. Since we made it a symbol, this is easy. Using 
the arrow tool, single click the text to select it (be sure 

you are in frame 1). In the Property Inspector, make a 
change under Color—set it to Alpha. Then, drag the 

slider down to zero.  
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The words should disappear, but the blue box should still be there indicating that you haven’t 
messed anything up... you just changed its alpha (transparency value). 
 
If you “scrub” (fancy word for moving the playhead across the timeline), you will see the words 
are completely transparent for the first nine frames, but when frame 10 hits, BAM, words. We 
want them to fade in, so make the following change—click in frame 5 on the timeline (really, 

any frame between the start and end one is fine). Then, in the Property Inspector, set Tween to 
Motion. You can also set the rotation (I set mine to 1 CW—clockwise) and the ease (I set mine 

to -100, which means it starts slower and speeds up at the end). 

 
 

Now, scrub the timeline and see it in action.  You can also press Enter up there and watch it 
play.  

 
SAVE YOUR WORK!!  (File, Save As, save as Disney) 

 
Now, test the movie to see what we have so far (Control, Enter). Notice that the movie just 
loops and loops. It blinks when it gets to the Scene we haven’t created yet. Looping is the 

default in Flash. (click the LOWER X to close the preview window) 
 

Create a new layer by clicking the leftmost plus sign under the 
timeline. Name it ME. Just so we don’t mess up what we have so 

far, LOCK the presenting layer (click the dot under the padlock). 
 
APPLY: Apply what you just learned. Click in Frame 1 of the name 
layer. Create a second text symbol (graphic) called name_txt that 
says Your Name’s Disney Project. Align center. 
 
Take your newly made text symbol. Click, pause, click and drag 
the keyframe dot in frame 1 to frame 10. You will see your text 

overlapping each other, so don’t panic. Insert a keyframe (F6) in 20 on the name layer. Then, 
click back in frame 10 and drag the text off the top of the stage. Then, right click between 

frames 10 and 20 and Create Motion Tween. 
 
Next, let’s make it stay up there a little bit and then fade out. Insert a keyframe in 30 and 40. 
Click the text symbol while in frame 40 and change the alpha to 0%. Insert a motion tween 
between 30 and 40. Lock this layer. 
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Now, unlock the presenting layer. Insert a keyframe in 20 and scoot the text up so it will be 

above the other text. Insert a motion tween between 10 and 20. Then, insert a keyframe at 30 
and 40. Click the text symbol while in frame 40 and change the alpha to 0%. Insert a motion 
tween between 30 and 40.  
 
 
 
 

Your timeline should look like this: 

  
 

Lock the layer, Save, and Test the Movie. 
 

END SCENE 1 (INTRO) 
 

PART C: Drawing in Flash 
 
Flash has drawing tools like many graphics programs. You can use shapes, draw freehand, and 

create polygons. These are all vector graphics. 
 
Before we get started, switch to our second Scene (click the correct one in the Scene panel—
Window, Scene). You’ll know you’re in the right place if the timeline turns to Layer 1 (don’t 
worry… all your other stuff is tucked safely away in the intro scene). 
 
Instead of working at the main timeline, let’s create a symbol first and then drag the completed 

symbol to the stage. For this exercise, we are going to create a castle. Rename Layer 1 to be 
castle. 

 
Let’s draw our flags. Click Insert, New Symbol. Make a graphic symbol named flag. For precision 

when drawing, turn on the grid (View, Grid, Show Grid). Use the pen tool with a black stroke for 
the triangle (click to set the points and be sure to double click and close the polygon) and draw 

the following as big as you want—you can always resize: (if you wish to temporarily change the 
background color while drawing, that’s fine)  
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NOTE: Use the line tool to draw the “stem” of the flag. See how the arrow has an L beside it 
when pointing to the corner? You can click and extend the point or adjust it when that appears. 

Try it! A curvy line by the pointer (when pointing to shapes that are NOT selected) will curve the 
line. 

 
Next, fill in the flag with the appropriate color (blue). Click the fill bucket, pick your color in the 
Property Inspector, and then click in the shape. In the event it will not fill, access the special fill 
tools at the left of the screen. You might need to close gaps. 

 
 

After your flag is finished, click out 

of the symbol to return to the main 
scene. The flag should disappear 

(that’s okay…it’s in the Library). 
You can no longer edit the flag 

without getting inside the symbol 
(double clicking it in the Library). 
 

This means you are 
editing a symbol and 

are inside the symbol 

If your symbol is not centered 

roughly on the crosshairs, you 

will want to draw a box around 
the completed flag (using the 

black arrow) and align it. 
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Since it appears we are building Legos here, let’s make some more “building blocks for our 

castle.  Use the rectangle tool and the pen tool (for the triangle) to create a new graphic symbol 
called tower1 (Insert, New Symbol). Draw the items as shown at right. Use a purple fill for the 
balcony and top and a light blue for the tower. 
 
Next, using the black arrow tool, delete the unneeded lines in the balconies by clicking each one 
and pressing delete on the keyboard. 
 

 
 
Now, let’s assemble the tower. We have to be careful about this because Flash is quirky about 

Legos…I mean, shapes. To select a part, double click it. A single click will select the fill and not 
the stroke. That’s bad. Also, be careful not to lay shapes on top of each other. They delete each 

other and that’s bad, too. To prevent that, we could have created each part on a different layer. 
Or, we could convert each little part into its own little symbol. Let’s do the latter. 

 
With the black arrow tool, double click the rectangle part, press F8 
to convert to a symbol, and name it tallpart. Now, it’s a symbol (in a 
symbol, mind you!). Do the same for the balcony part. Don’t do the 
triangle topper yet, though. We’re going to curve the bottom of it 

first. Click totally off of the triangle (in the open space). Then, point 
your mouse to the bottom side and get a curvy indicator. Click and 

drag.  
 

Then, double click the triangle thing and convert it to a symbol 
called topper. Now, all three parts are symbols (in the tower 
symbol).  

 
Zoom out. As you assemble the 
tower, if something is in the wrong 
order (layering-wise), click the piece 
and click Modify, Arrange to reorder. 

To size something up or down, click 
the piece and then click the free 

transform tool 
and resize. To obtain another piece 

(Lego), press F11 and drag it from the 
Library. Assemble your pieces as 

follows (don’t forget your flag from 
the library!): 

 
 
 

Draw the long (bottom layer, if you will) 
rectangles first; if you put the smaller 

rectangles on top and deselect them and 

try to move them, they will mess things up. 
Undo if you mess up; don’t try to fix it. 



Disney Project (Basic)  Page 9 

Then, return to the main scene and Save. There should be nothing on the timeline in this scene 

because we created the symbols in their own windows and stored them in their library. 

 
 
Now, let’s make the big castle. Create a new symbol (graphic) called castle. We are going to use 
two layers. Add a second layer and lock Layer 1 (you can rename the layers if you want).  
 
On Layer 2, we are going to create the middle of the castle using a rectangle. Then, draw an 
oval and use the line tool to bisect it in the middle (this will be used to make our door): 

 
 
  
Double-click the bottom half of the oval. Press delete. Delete the extra black line. It should look 

like this-- . Then, make the door whatever color 

you want, double click it, and drag it into place. 
 

Next, drag two towers out of your library and place them 
beside what you just drew. Then, delete the top line. 
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Now, lock Layer 2. On Layer 1, add your towers and build the higher part. 
Use the free transform tool as needed. When finished, return to the main 

scene.  
 
 
 
Here’s my castle— (DisneyWorld, here I come!) 
 

 
 
Drag the castle out of the Library (F11) to the stage (where we named the layer castle.. Position 
at the bottom left. You might want to change your background color back to a midnight blue at 
this point. Or you can wait...up to you. Lock the castle layer and add another layer called 
tinkerbell. 
 

PART D: Movie Clips and Custom Cursor 
 

Flash has the ability to customize the cursor. This part will show you how! 
  

Next, let’s do something fun. What’s DisneyWorld without Tinkerbell? We are going to use a 
Tinkerbell icon for a cursor. Create a new layer, and call it Tinkerbell. 

 

Use Free Transform to resize the 
castle if it is too big; Use shift to 

maintain ratio. You may want to 

use the arrow keys instead of the 
mouse for more precise 

positioning. 
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Click on the tinkerbell layer. We want to 

make Tink our cursor. To do that, she has 
to be a movie clip. So, let’s create a new 
one. Modify > Symbol (or F8)and select 
movie clip as the type. Name it tink.  
 

In the editing window, Drag her (tink, the movie clip) onto the stage and just stick her in the 
corner someplace. 

 
Name this Symbol "tcursor" in the instance box of 

the Property Inspector.   
 

Select the first Frame of your tinkerbell layer. Go to Action panel (If your Actionscript panel is 
not open, Press "F9").   

 
With Frame1 of your layer selected, type the below script in your action panel  (just copy/paste 

the red text). 
 
/* Custom Mouse Cursor 

Replaces the default mouse cursor with the specified symbol instance. 
*/ 

 
stage.addChild(tcursor); 

tcursor.mouseEnabled = false; 
tcursor.addEventListener(Event.ENTER_FRAME, fl_CustomMouseCursor); 

 
function fl_CustomMouseCursor(event:Event) 
{ 
 tcursor.x = stage.mouseX; 
 tcursor.y = stage.mouseY; 
} 
Mouse.hide(); 
 

//To restore the default mouse pointer, uncomment the following lines: 
//tcursor.removeEventListener(Event.ENTER_FRAME, fl_CustomMouseCursor); 
//stage.removeChild(tcursor); 
//Mouse.show(); 
 
Let’s create (temporarily) a “stop” to this so we can see Tinkerbell in action.  
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Insert a stop action in that layer so that the scene 
won’t just play for one frame and then restart. 
Open your actions panel while in frame 1 of the 
new layer. Type Stop(); or, while the Actions Panel 
is open, click the Code Snippets (top right), 
ActionScript > Actions > Stop a Movie Clip and it 
will insert a stop action for you.  

 
Change your background color to a midnight blue if 

you haven’t already. Save and Test Movie. 
 

  
 

 
Now, let’s get to the fireworks (literally!).Lock all 

layers and create a new layer called fireworks1. We 
are going to use the firework symbols in your Library.  
Back at the farm, click and drag firework_red.gif out into the firework1 layer. If you Test Scene, 

you’ll see the firework do its damage, but it’s just not quite right. We don’t see the firework 
launch and it just plays over and over…not realistic. And we want to be real! 

 
So, we are going to create a “stick” that launches into the air. Delete the firework off the stage. 

Create a new graphic symbol (stick). Just take the pencil and make an orange slash.   
Return to the scene, zoom in, and drag stick out to the stage on the fireworks1 layer. Place it at 
the bottom of the screen at the right someplace. Insert a frame at 20 on all layers (click the 
frame, right click, Insert Frame). Then, insert a keyframe in 20 on the fireworks1 layer. In 
keyframe 20, move your stick up there to the sky. Insert a keyframe in 21, drag your firework gif 
from the Library out to the top of the stick and delete the stick. NOTE: Animated gifs import lots of 
bitmaps; you might wish to hide them in a folder in the Library  

 
 
Now, we want to make the stick actually move. Click between frame 1 and 20 someplace on 
that layer and insert a motion tween (Right click, Create Motion Tween). Then, insert a frame in 
all layers in frame 50. 
 
If you Test Scene right now, you’ll find nothing happens. That’s because we have a stop action 
in there. So, on the stop layer, click pause and click and drag the first frame down to  
50th frame. The little A should move. 
 

If you Test Scene right now, it works but your firework loops. That’s because it is a movie clip 
and movie clips always loop, even with a stop action in the movie. However, we can put a stop 

action INSIDE the movie clip so it will stop. 
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Double click the 
firework on the stage 
(the red dot). Right click 
in the next empty 
frame, insert a blank 
keyframe, and then 
insert a stop action in 

the Actions panel 
Stop(); 

 
With the black arrow, double click the firework on the stage (the dot). Right click in the next 

empty frame, insert a blank keyframe, and then insert a stop action in the Actions panel (F9). 

 
 
Your timeline should look like that INSIDE the fireworks movie clip.  Notice that all those black 
keyframes are basically frame-by-frame animation from the imported gif. Return to the Scene. 
Now, Test the Movie and see how it looks! 
 
SUGGESTION: 

You may find your stick is too small or big. If so, double click and fix it and then return to the 
main timeline. Any changes made will be forever changed in the Library, too. If you were doing 

this in a class with more time, I would suggest repetition at this point. Have students create a 
second firework that starts someplace later in the timeline on a new layer. Make it a different 
color, even.  
 
EXTENSION: 
One good thing about Flash is that you can copy things. So, if you have time, try copying the 
fireworks1 layer. Highlight all the frames on that layer, right click and select Copy Frames. 

 
Create a new layer, click in the first frame, right click and select Paste Frames. Then, 

click/pause, click and drag the keyframes (black dots) so they are staggered more.  
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Be sure to click in the second of the two dots in a row and move your firework to some other 
location. You can even click on the firework, go to the Property Inspector, and select Color and 
change the tint to another color! 

 
 
If you end up with any extra frames at the end (I did…), highlight those frames, right click, and 

Remove Frames. 
 

 
 

For more fun, obtain a Mickey Mouse gif and add it on a new layer to your scene. 

http://www.mickey-mouse.com/mickeyclipartmain.htm 
(see back page for instructions on how to animate him!) 

 

  

http://www.mickey-mouse.com/mickeyclipartmain.htm
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PART E: Replay Button 
 
Want to start a movie over again? How about making a button?! Flash has built in buttons that 

save you time and hassle. We’ll use a premade button to make this part go fast. 
 

1. Lock all your layers. 
2. Create a new layer called replay. 
3. Insert a keyframe in frame 50 on that layer. 
4. Pull replay_btn onto the stage 
5. Size down the button for your page (Edit > Free Transform). 
6. Now, click on your button and in the Property Inspector, give 

it the instance name but.  

 
7. Now, we need to add some Actionscript to make the button work. Access the Actions 

panel (f9) and press Code Snippets (top right).  
 

  Under Timeline Navigation, choose the bottom one. 
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8. This puts in a bunch of code for you (yay for Code Snippets and not having to type all 

that script!).  You do have to edit the code to tell it to go to your starting scene (intro): 

 
9. Alternatively, you could copy/paste this code: 
 

/* Stop at This Frame 
The Flash timeline will stop/pause at the frame where you insert this code. 

Can also be used to stop/pause the timeline of movieclips. 
*/ 

 
stop(); 

 
/* Click to Go to Scene and Play 

Clicking on the specified symbol instance plays the movie from the specified scene and 
frame. 
 
Instructions: 
1. Replace "Scene 3" with the name of the scene you would like play. 
2. Replace 1 with the frame number you would like the movie to play from in the 
specified scene. 

*/ 
 

but.addEventListener(MouseEvent.CLICK, fl_ClickToGoToScene); 
 
function fl_ClickToGoToScene(event:MouseEvent):void 
{ 
 MovieClip(this.root).gotoAndPlay(1, "intro"); 
} 
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10. One more thing…if you Test Movie, you’ll see Tinkerbell goes behind the button. That’s 

because she is on a lower layer. Drag her layer to the top of the layer list and Test Movie 
again. 

 
 

Animated Mickey Instructions 
 

1. Locate the patriotic Mickey Mouse in your Library.  
2. Create a Mickey layer. Drag Mickey_up from the Library onto that layer. (To be safe, lock 

all others layers) 
3. Convert him to a movie clip symbol. While he is still selected (after tracing) press F8. Use 

the settings below: 
 

  

4. Double click Mickey_up so we can get inside his movie clip. Rename his one and only 
layer kick. On his timeline, insert a keyframe at 4. 

5. On frame 4, swap Mickey-Up for Mickey-Down 

 
6. Now, he should be animated. Return to the main scene and Test Movie to see him in 

action! You could make a new layer inside his movie clip and perform other actions, too, 
such as tipping his hate, blinking his eye, etc. Fun, fun! 

 
 


